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Introduction

ConQuest is the desktop search interface to the Cambridge Structural Database
(CSD). All textual, numeric and structural data stored within the CSD can be
searched using ConQuest. ConQuest provides an extensive range of flexible
search options including searching based on compound name, formula,
elemental composition, and literature references to name a few. Chemical
substructure search in ConQuest also includes the ability to define chemical
constrains such as charge, hybridization state and cyclicity.

Before beginning this tutorial, ensure that you have a registered copy of CSD-
Core or CSD-Enterprise installed on your computer. Please contact your site
administrator or workshop host for further information

Learning Outcomes
This tutorial will guide you through using ConQuest for substructure searching. At
the end of this tutorial, you will be able to:

e Use 3D information in searches.

e Search with geometric constraints.

o Use subsets to restrict search results.

This workshop will take approximately 1 hour to be completed. The words in Blue
Italics are reported in the Glossary at the end of this handout. A review of the
ConQuest interface is also at the end of this handout.

Pre-required Skills
For this tutorial, we recommend running through the introduction to ConQuest
and visualizations in Mercury workshop which can be found here.

Materials
There are no additional materials required for this workshop.

0%

Search Reset

@ CCDC ConQuest (1) - m]

File Edit Options View Databases Results Help
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Draw
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Author/Journal
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Experimental
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Refcode (entry ID)
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Using 3D Information and Subsets in Searches

Gathering 3D data for comparison

Queries based on 3D geometric constraints involving atoms, centroids or planes
give important data which help relate the structure of a molecule to its function.
The ConQuest Draw feature allows the incorporation of 3D queries or filters,
which can be used to extract metric data from the molecules in the CSD or to limit
searches to specific spatial arrangements of chemical moieties. This can be
extremely helpful when doing structure-function or structure-property research
in fields ranging from drug discovery to materials engineering.

The following example relates to a pharmacophore used for drug discovery but
can easily be adapted to organometallic or organic-materials cases. This example
looks at the relationship between the propyl group and the pyrazole pyrimidine
aromatic plane of sildenafil (Viagra), shown at right. This tutorial assumes you
have prior knowledge of the Draw function in ConQuest.

sy
==
|

The 3D structure of sildenafil (QEGTUT, left)
and a 2D sketch of the fragment used for
this exercise (right).

1. Open ConQuest and click the Name/Class button to start a text-based search
for a compound name. Type the word sildendfil in the “Compound Name”
box. Click Add to include the word sildenafil in the “Contains:” box. Click
Search to begin the search.

2. Inthe Search Setup dialog box, tick the box for “3D coordinates determined”
and then click Start Search. At least 40 hits will be returned. These hits all
contain the word “sildenafil” in the compound name or synonym field.

3. Click the Chemical tab on the left of the View Results display. This shows the
chemical information for each hit including the Name (typically IUPAC) and
any synonyms supplied by the depositors. The text that matches your search
term will be highlighted in yellow. Scroll through your hits to see what
matches were found.

1 As of version 2023.1 of the CSD.
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To assess the relationship of the propyl group to the aromatic plane of the
pyrazole pyrimidine moiety, we will need to conduct a 3D geometry search.
Click on the refcode QEGTUT in your hitlist. This is the structure of neutral
sildenafil, with no solvents or other molecules present. Click the Diagram tab on
the left to show the 2D drawing.

4.

You can use this 2D diagram as the basis of the 3D geometry search. Click the
Use as Query... button. Make sure the box is ticked for “Include hydrogen
atoms” in the Use-as-Query Options dialog box. The radio button that should
be ticked is “Biggest chemical unit only”; the other options are greyed-out
because there is only one molecule in the structure. Click OK to continue. You
will get a warning that the OEt group cannot be converted and instead
ConQuest is using O. We do not need to worry about this group, so simply
click OK.

ConQuest now shows the structure from QEGTUT as Query 2. We will need
to edit this to remove some features of the structure and to add our 3D
parameters. Click Edit... to edit the query. This will launch the Draw window.

First, delete all atoms but the pyrazole pyrimidine and propyl moieties (see
figure 7). To do this, click the Erase button on the left of the window. This will
change your cursor to a square; click on each atom to be deleted.

Because we want to search the torsion angle of the propyl ring, we will need
to draw out all the carbon atoms in the chain. Using the procedure in Step 6,
delete the “Et” group. Then click Draw and add 2 carbon atoms to complete
the propyl group. Delete the hydrogen atoms on the carbon atom directly
bonded to the ring by right-clicking on this carbon atoms with the added
hydrogens, select Hydrogens and then select Clear.

Now we need to add in the search for 3D parameters. Click the ADD 3D
button to launch the Geometric Parameters dialog box. This is the window
for defining all 3D constraints and objects. Click each atom in the rings to
select them. They will be highlighted in blue. Click the Define button next to
“Plane” to define the plane.

| @ CrD Contiaest (1) search [5earc
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Cancel 0K
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9.

10.

11.

12.

13.

14.

15.

16.

Now we need to define the distance of the propyl group to the plane we have
just defined. Click the middle carbon of the propyl chain to select it, then
select PLN1 in the Defined Objects section. Then click the Define button next
to “Distance:” in the Valid Parameters section.

There is now a distance constraint of unspecified length. For this search, we
do not want to restrict it as we merely want to gather data.

To specify the torsion angle of the propyl chain, start with the terminal
carbon (C32) and click the three carbon atoms of the chain and the carbon
atom in the pyrazole ring (C24). It is important to click these atoms in bonding
order. Click the Define button next to “Torsion:” in the Valid Parameters
section as you did for the distance in Step 10. Again, there are no limits on
this angle.

You will now see two entries, abs(DIST1) and (TOR1), in the 3D Parameters
box in the upper right hand of the Draw window. Click the Done button in
the Geometric Parameters dialogue box.

Click Search to launch the searching window. You will be prompted to
“Overwrite existing Query.” Click Yes to overwrite and save this as Query 2.

Rather than searching through the entire database, we want to search only
the structures in the sildenafil hitlist we just produced. Click the Select Subset
button in the Search Setup dialog box.

In the Restrict Search dialogue box, tick the radio button to select Entries in a
hitlist loaded this session. A box will appear with the text “Restrict based on
search this session” and a dropdown box labelled search1.

Click the search1 box to select it. The hit list information will be shown in the
Current Restrictions section. Click OK to close the window.

® @ Geometric Parameters %
To construct Parameter/Object: To construct Parameter/Object:
3 32[: Select atoms (main window) or object (list below) 3 Select atoms (main window) or object (list below)
28 Hit 'Define’ to construct Parameter/Object » Hit ‘Options...” to et constraints or change options
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. 1% 17,
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pot | oo |
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~ .
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(" Entries in saved hitlist combination
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m Clear | Canclll
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17.

18.

19.

20.

21.

22.

23.

Now in the Search Setup dialogue box, note that under Available Databases,
there is an additional line below the CSD version that indicates the search is
restricted to 40 refcodes (as of the 2023.1 release). Make sure both boxes are
ticked and click Start Search to begin the search.

In the View Results tab, notice that now the results have the matching
fragment highlighted, as well as both parameters measured. The data is
measured, now it needs to be analysed. Click Analyse Hitlist and select
Analyse Data.

In the Analyse in Mercury dialogue box, make sure the box is ticked to
“Include Defined Parameters.” We are not interested in any other
parameters, so simply click the Analyse in Mercury button to view the data.

This launches Mercury and the Data Analysis window, which shows all the
data from your query in a spreadsheet, sorted by refcode. NOTE: The Data
Analysis window may be behind the main Mercury display.

To view the distribution of distances in this hitlist, click the abs(DIST1) header
in the column to highlight the column, then click Plots from the top menu and
then select Histogram.

The distances seem to cluster in two regions, one centred on 0.3 A and one
centred on 1.4 A, with some outliers in the middle near 0.8 A. Click on this
bar of the histogram to highlight the corresponding entry in the spreadsheet.

You will see QEGTUT highlighted in the spreadsheet. This is the structure of
sildenafil with no solvents or other molecules present. You can click on this
entry in the spreadsheet to see the structure in Mercury. Click to select other
bars in the histogram and the corresponding entries to see the other hits.
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Filters ', Advanced Options
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Single query being used. Search will find structures: "
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statsewch Cancel Recet ‘
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W Include Defined Parameters
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24. To see how the torsion angle of the propyl group relates to the distance

25.

above the plane you can create a scatterplot. To do this, click the TOR1
header to select the torsion data column in addition to the distance data.
With both columns selected, click Plots from the top menu and then select
Scatterplot.

The scatterplot shows a similar clustering to the histogram, which is what we
would expect. The data on the left of the plot, i.e. smaller out-of-plane
distances, show larger torsion angles. The data on the right-hand side of the
plot, i.e. larger out-of-plane distances, correspond to smaller torsion angles.
Close ConQuest as you will be drawing a new structure in the next section.

election | | Plots | Statistics
Histogram
Folar histogram

pronr) Scatlerplot
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CHALAL feat plot
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Searching the CSD with distance and angle constraints

A major component of structure-property or structure-function research involves
searching for a specific geometric arrangement of atoms. For instance, scaffold
hopping in drug discovery involves searching for known compounds with the
same chemical moieties arranged around a variable molecular core. Using
ConQuest to perform this type of search can return a variety of known crystal
structures of potentially bioactive molecules.

The following example, based on the pharmacophore shown at right, shows how
to set up a geometry-based search with specific metric restraints.

Open ConQuest and click Draw to start a new substructure query. Draw the
carboxylic acid group, and the two toluene groups (see figure 1). Make sure
they are not bonded to each other. Make sure the acid hydrogen is included
by right-clicking the oxygen atom, choosing Hydrogens and then Generate.

Following the procedure above (Step 9, etc.) click ADD 3D to launch the
Geometric Parameters dialogue box. Click each of the six C atoms in one ring
to select them, then click the Define button next to “Centroid:” to define the
centroid. Repeat the centroid definition step again for the other aromatic
ring. Then repeat each selection but click Define next to “Plane:” in order to
define the planes, one each for each aromatic ring. In the end you should
have four objects in the Defined Objects box: two centroids and two planes.

Dihedral angle ™

between planes:

20°- 80°
/ N 40-6.0A The sample pharmacophore, known
50-6.0A/ \ & ) for CIC-K CI- channel activation
/ \\ O (DOI: 10.1073/pnas.0708977105)
- HO
-~
[ J
8 To construct Parameter/Object:
b 26 i
1 2 e 6277 NG Select atoms from main window
//C\\ //’c\ F = ‘QCI Hit Define’ to construct Parameter/Object
F C‘ IC CI ! ! ! ! Current Selection:
i ! i i 5 108 12 C1c2c3c4C5C8
Ic\\ //C‘ c\\ //CI A =" \\\“ ~// Valid Parameters ALP
TR TP [ setectea Define

‘ All Parameters... c e Jemec e

c c

o o Defined Objects: 74 184 Valid Objects

"~ centt m\ﬁcg/ Piane Dstne_|
‘ PLN1 Centroid Define ‘4’/
! PLN2 1o, ot
Reset Done
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E ° 5 e S @
; ; Jeo 28, | T ,
3. To ensure the search returns structures with these groups in the correct e N, 3| S, e e \ﬁc, ki | e s
- _ ; - : . o e d fors haeg bor e
geometry, various distances and angles must be restrained. ’—+—+—‘ o | r— ] D R | Al
3 5 e c c (] 2 - € Curent Selection
Cx C = 5 N - > /
N, P ‘\‘l‘c// CENT1CENT2 y // \";'c =
© Walid Paramels c
. . . . . Distance ﬁ Apuner. | Valid Parameters T —
4. To restrain the distance between the two ring centroids, click on CENT1 and 7t e e A wl - arametes.
CENT2 from the Defined Objects section to select that distance, and then click M e - ”om\‘i /fo <« —
the Define button next to Distance. Choose “Intramolecular Distance” from o e 1 ° \
) . . Dummy Poind k oG (Distance)
the Distance Type dialogue box to ensure these features are both in the same == .@m g — M: :t an)m —
molecule and click OK to exit the dialogue box. - e

CONTACT: crystal structure for, e.0.,

Selectthis option 1o find non-bonded interactions hoit non-bonded interactions

betwean mese ragments

5. Back in the Geometric Parameters dialogue box, click Options... to define the 25 UMT Fom 50 o 60 )

Ifyou Select s option then the distance calculated
may be arbiitarily calculated for 5ome entries uniess

limits on the centroid-centroid distance. In the “LIMIT:” boxes, type 5.0 for o D
“From” and 6.0 A for “to”. Click OK to set the range limits. You can choose to =c |
rename the parameter here, but we will leave it as DIST1. e _— e
it e | DTt
. . . S ac'/f (N cance | x|
6. Repeat this step for the distances between each centroid and the central 6 F ? T g || [ |
carbon of the carboxylic acid: Click CENT1 in the Defined Objects: section and E'c\\\\ P ’“‘C\} / e et e, Y i i
then click the central carbon in the carboxylic acid. Click the Define... button T [ [ I I I I =
next to “Distance:” and make sure the button is ticked next to . ° ﬁ? m— I “V"“
“Intramolecular Distance” in the Distance Type dialogue box. Click the & optors. | =T Y =l
Options... button and set the range limits to 2.5 and 6.0. Repeat again for MC| Cvor_,\_ P t' - |
CENT2 but this time set the range limits to 4.0 and 6.0. ki e e
. . 3D Parameters: ) WT:Z a,:;.::;mw of any selected hunchon
7. Todefine the dihedral angle between the planes, select both planes from the 8| Liem ——
Defined Objects section. Then click the Define... button next to “Angle”. Click g:gg P
Options... and set the limit between 20° and 80°. ANG1 - Q
8. You should now have four entries in the 3D Parameters box in the Draw onca] ox |
window. Click Done to close the Geometric Parameters dialogue box. You can @ search senp -
click on each defined parameter to review the defined objects. 9 MMme:.m.m.: o p—
¥ CSD version 5.44 ( April 2023) <
9. Click the Search button to launch the Search Setup dialog box. For this co
example, since we are looking for potential pharmaceuticals, we are only ™ Only & Nen-disordere
interested in organic compounds. In the Filters tab, tick the boxes for “3D FNP “”
coordinates determined” and “Only Organics”. et e s ||~ bt pomese
seect subset Jear Subset ™ Noions
Single query being used. Search will find structures: miE : '[‘; S
wherethls&\stme:
Srgafiometallic
Start Search | Cancel| Reset
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10. Click Start Search to begin the search. The search will take a couple of 10 | ¢ | remm -
minutes and should return at least 284 hits (2023.1 release), with the — o [
corresponding distances and angles from the 3D geometry queries that have e Parameters #“&“‘T
been included. = e

11. Click the Analyse Hitlist button and choose Analyse Data. In the Analyse in = w
Mercury dialogue box, make sure the box is ticked to “Include Defined o A 5536 [iamsosn
Parameters.” then click the Analyse in Mercury button to view the data. This - oo ”‘Ez
will load all the hits into Mercury for visualisation as well as launch the Data | - . 3
Analysis window. Explore the structures visually to see what kinds of ) - = ‘
molecules have been identified. Use the Data Analysis feature to explore the e o N e
relationship between various parameters. You will find a diverse set of — el
molecules returned by this search. Adding more functional groups and — o —
changing the limits on the distances and angles will affect the hits returned [@ vt oo RS
by the query. ‘n* ——— -

Conclusion = I - 11

These exercises show how to set up 3D parameters for searching metric data and P M

for filtering the hits returned based on specific limits. These tools are extremely S EED o0 snn m

useful in creating advanced searches to identify molecules, ligands or moieties L e i?ﬁ;ﬁ g::;ﬁ =

that may exhibit useful properties such as increased bioactivity or catalysis. ,u ?

| Ve  ow s

Exercise

e Repeat the exercise but change the limits on the distances and angles to : m M
make them broader. What do you find? o e e

R ot Rl

Summary | SoE

This workshop introduced using 3D parameters while searching in ConQuest and gt :;3 3:?: 54; )

how to utilize geometric constraints. You should now be familiar with:
e Using the compound name search function.
e Using previous result as a new query.
o Defining 3D parameters in your search.

e Using subsets in your search.

e Defining geometric constraints in your search.
e Exporting and visualizing structures in Mercury.
e Data analysis in Mercury.
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Next Steps

You can explore other workshop materials for ConQuest from the CSD-Core
workshops section. The ConQuest user guide and other available ConQuest
documents can be found by selecting ConQuest as the Product from the
Documentation and Resources page.

Feedback

We hope this workshop improved your understanding of ConQuest and you
found it useful for your work. As we aim to continuously improve our training
materials, we would love to get your feedback. Click on this link to a survey, it will
take less than 5 minutes to complete. The feedback is anonymous. You will be
asked to insert the workshop code, which for this self-guided workshop is CQ-
002. Thank you!

Glossary

Centroid - In Mercury, the centroid is the geometric centre of a group of
selected atoms.

CSD Refcode - A database reference code, containing 6-8 characters and used to
identify entries in the CSD. Learn more about CSD Refcodes in the blog:
https://www.ccdc.cam.ac.uk/Community/blog/post-20/ .

Hitlist - A hitlist is a subset of CSD entries which can include search results,
refcode lists, or the results of combining these.

Subset - Subsets break the database down into more manageable subcategories
and are an efficient way to search a certain category of compounds.

Substructure — A substructure is a part or section of a whole molecule.

Torsion Angles - Torsion angles are used to describe conformations around
rotatable bonds. The torsion angle between 4 atoms A-B-C-D is the angle by
which the vector A-B must be rotated in order to eclipse the vector C-D when
views along the vector B-C.

Centroid definition in
ConQuest

Je
e
1
|
. 3 |
!
Sc
e
‘\.C /f
c


https://www.ccdc.cam.ac.uk/community/training-and-learning/workshop-materials/csd-core-workshops/
https://www.ccdc.cam.ac.uk/community/training-and-learning/workshop-materials/csd-core-workshops/
https://www.ccdc.cam.ac.uk/support-and-resources/documentation-and-resources/
https://www.surveymonkey.co.uk/r/CCDC-Online-Workshop
https://www.ccdc.cam.ac.uk/Community/blog/post-20/
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Review. ConQuest Interface

1. Launch ConQuest by clicking the ConQuest Icon . on your desktop or
launching it from the Start or Applications menu.
2. The ConQuest main window shows all the search routines you can perform
on the left-hand side of the window.
3. Therow of tabs across the top of the window will guide you through the steps
of the search process.
4. Some example searches are
a. Draw —substructure and 3D information searching
b. Author/Journal — bibliographic searching
c. Experimental — experimental set up searching
d. All Text — generic text-based searching
5. The majority of the searching we will do in these tutorials will be
substructure searching, so we will focus on the Draw tab here.

@ ccoc ConQuest (1)

File Edit Options View Databases Results Help

Build Queries | cunbmm:um Manage Hitlists ' View Results | 3

Draw
Peptide
Author/Journal
Name/Class
Elements
Formula

Space Group
Unit Cell
Z/Density

@ furhorfloumal (1) New

Authors Names.

Exact
sumame

New Box

- a] %

4b

Experimental
All Text
Refcode (entry ID)

20 Mat. [2017]

3 Biotech [2013]
ACASpring) [1974-1575]
AC.SMitg.172Inorg. [1976]
1A£PS Pha

ACASer2 [1977-1384]

ACS Appl. Bio Mater. [2019]

Search Reset

CCOC Number

(Req:
Brown will hit Brown:

FHAllen, O'Hara,

Journal Name

Type part of Joumnal name above to namow lst displayed
Select required journal in list below

ciTech [2004-2013)
2 ACA Abstr.Papers(Winter) [1967-1986]

ACGC Chem Res.Commun. [2001-2009]
ACH-Models Chem. [1994-2000]

Volume (14, 1.2 etc) | Page (2125-A etc)

(Enter numesic part only, e.g. 123456 or 123/456)

y
ing unless Exact sumame' is selected)

Year (1988, 2001 etc)

during —

| Comcd | Reset

4c

@ Experimental (1) - New - m] X

R-factor = — @ fractional %

™ Exclude disordered structures
[~ Exclude structures with unresolved errors
Average e.s.d. of C-C Bonds Any —
[~ Exclude powder structures
Temperature of I
Structure Determination

0

oK =C

Room Temperature G10K

All values in the range 283-303 K are stored as Room Temperature

Radiation Source  Any  —

search | store |

Cancel | Reset

@ Al Tex (1) - New

Text Selr:n‘ Required Fields

Either select from list

acicular A T
sir-sensitive
bar

black

blade

block

blue

brown
colorless
column
conductor
cream

cube o

New Bax

or enter in bofes) below

The search will find words starting with what is entered in the boxes.

If two or more words are typed into the same box the search wil
be for the exact phrase specified. To find entries containing
two or more words that need not be adjacent, use the New Box
button and type the required words into separate input boxes.

Cancel

Reset
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Review. Draw Window
All drawing takes place in the central white area of the Draw window. In addition

to creating 2D chemical structure sketches, the Draw window allows for the
inclusion of 3D parameters for searching or for filtering.

ConQuest sketching conventions
e Left click in the sketcher to insert the selected atom type
e Left click and drag to sketch two bonded atoms

e Use the Edit button to modify properties of or delete atoms, bonds or
entire substructures

e Right-click on atoms or bonds to modify their properties

o Use the Templates... button to pick from a list of CSD editor devised and
drawn substructures

e Use the More... button to find less frequently used element types, or
generic atom type groups (e.g. halogens), or define custom element
combinations (e.g. Cor N or O).

File Edit Atoms Bonds

Click and dra

‘:;?ﬁ;?“ Drag to an ex
>

ptions  Help

Define bonds, angles or torsions to be
monitored during the search, or define
geometric objects e.g. planes, centroids
that can be used in computing geometric
parameters

Ring template
selector or
builder

olo]

RingMaker

<

Templates...

[c H|o|n|s|p|F|ci|any|more..| Groups..| [ C | Bond:  Single

~

Next Atom: C 3D Parameters:

Next Bond: Single

Contacts:

S Shs Search
Store

Cancel

]

A

List of templates
for challenging
substructures
e.g. adamantane

Choice of specific or general atom
types/functional groups

Choice of
bond types




